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1.Introduction        
Movement is important in design, but it can be quite difficult to imagine. In the 

2d sketched world of your design, visualising movement typically involves a 

great deal of abstraction to translate the 2d sketches into a 3d imagining in the 

mind. This can be quite hard to do once you begin to imagine the detail required 

to create the 3d form, but you use this imagined object to ask questions of your 

design. You visualise your design from the eye of the user, and imagine the many 

possibilities of use of your design. You ask your design things as simple as what 

is the view a visitor experiences of your design as they briskly walk down the 

footpath leading to the entrance? does it change? what is revealed or taken 

away? These simple questions ask you to imagine moving through your design 

as a visitor or an occupant would, at a human scale.

The beauty of 3d software like Sketchup is that you can create this 3d form quite 

easily. Visualising the design in the eye of the user simply involves rotating the 

camera to the desired location and adjusting the field of view to suit the human 

eye (roughly about 60°). The trouble lies in movement. Sketchup can simulate 

movement by its animation effect, called when transitioning between scenes. 

Sketchup controls this transition between scenes as smoothly as it can, but (as 

you probably have experienced) this doesn’t lead to a nice feeling of walking 

through the design. Sketchup also has a tool called walk, which allows you to 

explore the model by clicking dragging. Dragging the mouse up and down 

moves the camera forwards and backwards, and dragging the mouse left and 

right pans the camera left and right. Things like looking up and down, changing 

the field of view, rolling the camera, moving gently up a staircase, or simulating 

friction and acceleration are impossible to do whilst you’re using this tool, but 

they’re essential features of movement and camera animation.

Floating Camera was designed to simulate a video game style movement 

through your model. Used in the early design phases, Floating Camera enables 

you to visualise movement through your model on a human scale. Exploring your 

model in this way gives you the ability to identify the design issues of narrative 

and detail that wouldn’t be possible with the native Setchup tools. It helps you 

imagine the paths that viewers will take in and around your model, and design 

to suit these paths. Used in the late design phases, Floating Camera enables you 

to produce good quality and smooth animations for presentation, which explore 

your design in greater experiential detail than a plan, section or elevation can 

produce.
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2.Installation         
2.1 Windows & Macintosh Installation

If you’ve installed a previous version of Floating Camera, you’ll need to uninstall 

it before you install the new version. To uninstall, first open the Sketchup Plugins 

folder in Windows Explorer (See Footnote #1. for typical locations for the Plugins 

folder).  Move the following files and folders to the Recycle Bin (Windows) or 

Trash (Mac):

 /floating _ camera.rb
 /floating _ camera-users _ guide.pdf
 /floating _ camera/

Download the latest version of Floating Camera from [plugin] Floating Camera 
at forums.sketchucation.com. The file you’ve downloaded is a zip file with the 
name FloatingCamera_x-xx.zip.

Extract the FloatingCamera_x-xx.zip zip file, open the folder ‘FloatingCamera_x-

xx’, th then copy the files inside into the Plugins folder. You’re Plugins folder should 

have the following files:

 /Plugins/floating _ camera.rb
 /Plugins/floating _ camera-users _ guide.pdf
 /Plugins/floating _ camera/

Now you have successfully installed Floating Camera. The next time you open 

Google Sketchup you should have a new toolbar with the Floating Camera 

icons displayed. If no toolbar is displayed, select the menu View -> Toolbars -> 

Floating Camera.

#1. The location of the Plugins folder varies depending on the operation system and the 
computer setup:

Windows 7: C:\Program Files (x86)\Google\Google SketchUp 8\Plugins\
Windows XP: C:\Program Files\Google\Google Sketchup 8\Plugins\

Mac General Location: /Library/Application Support/Google Sketchup 8/Sketchup/
Plugins/

Mac User Location: /Users/[user_name]/Library/Application Support/Google 
Sketchup 8/Sketchup/Plugins/

#NB: If you’re having trouble finding the Plugins folder, open the ruby console in 
Sketchup and type $LOAD_PATH then hit enter. Sketchup will output an array 
containing all the load paths for main plugins folders.
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3.Basic Use          
3.1 First Use

After opening Google Sketchup on your first install of Floating Camera you 

should be presented with a new Toolbar with three buttons:

: Floating Camera

: Controls

: Settings

Normally, you can load the Floating Camera by clicking on the Floating Camera 

button, but on first use clicking this button will also load the Controls window. 

We’ll get back to the Floating Camera shortly, but first we’ll need to set the 

controls and ensure there’s no conflicts between the controls you’ve chosen and 

any of Sketchup’s shortcuts. The Controls window will also load after first use if 

you’ve set any new Sketchup shortcuts that conflict with the controls, so don’t 

panic.

3.2 Controls
So here’s what the Controls window should look like:

Figure 1. Floating Camera Controls window (version 1.0b1)

You can access the Controls window by clicking on the Controls button in the 

toolbar:

Each text field represents the current key for its control. Fields highlighted in red 

represent either invalid keys or keys already used by Sketchup shortcuts. In the 

image above the control key to Toggle Collision Detection is aleady in use by 

one of my own Sketchup shortcuts. If you click your mouse on the text field then 

press any key on the keyboard the text field will change the control to that key. 

The Controls window will also check if this new key is being used by a Sketchup 

shortcut, and if it is, the field will remain red. 
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Make sure you’ve got your ideal controls and that no text fields are red then click 

on ‘Save’ and you’re Floating Camera will be updated with your new controls. 

Now you should be ready to use the Floating Camera, so lets talk about that 

next.

3.3 Using the Floating Camera
So you’ve set your controls to suit your navigation style and you’re ready to start 

floating around, cool. When you press the Floating Camera button  you’ll 

start the Floating Camera Tool. To control the camera, I’ve set some universal 

controls for basic movement:

: Up Arrow  - Move Camera Forward

: Down Arrow - Move Camera Backward

: Left Arrow - Move Camera Left (Strafe Left)

:  Right Arrow - Move Camera Right (Strafe Right)

: Space Bar - Exit the Floating Camera Tool

: Click-n-Drag Mouse Left -Pan Camera to the Left

: Click-n-Drag Mouse Right -Pan Camera to the Right

: Click-n-Drag Mouse Up -Tilt Camera Up

: Click-n-Drag Mouse Down -Tilt Camera Down

If you’ve used Sketchup’s walk tool, you might notice that these controls are 

quite similar, but there’s a crucial difference between the walk tool and Floating 

Camera. Floating Camera uses both the keyboard and the mouse to navigate 

through your model. This allows you combine the usual movements of the 

camera with tilt and strafe. This gives you the ability to move around the model 

whilst maintaining focus on one specific object.

3.4 Advanced Movement
Ok, so just moving around the model like a video game isn’t that special, but 

there are many more things possible with Floating Camera than just simple pan, 

tilt and move, so lets go into a little detail. Floating Camera’s advanced controls 

allows you to move the camera up and down, roll the camera clockwise and 

anti-clockwise, increase or decrease the field of view, toggle collision detection, 

toggle a restriction of camera movements up and down to the vertical (blue) 

axis, toggle camera height and toggle camera upright. Some of these are self 

explanatory, others need a bit of explanation:

3.4.1 Moving the Camera Up and Down

Using the keys you’ve set in the controls window you can move the 

camera up and down. Up and down will be relative to the camera’s 

direction of sight unless you’ve toggled the vertical restrict mode 

(I’ll talk more about this later). For example, if you’re looking almost 

directly down at an object, moving up and down will be like moving 

the camera horizontally (on the plane made by the green and red 

axes).
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3.4.2 Rolling the Camera

To roll the camera clockwise and anti-clockwise, first you must toggle 

off the camera upright. Then, using the keys you’ve set in the controls 

window, you can roll the camera clockwise and anti-clockwise. The 

camera will roll relative to the camera’s direction of sight.

3.4.3 Changing the Field of View

Increasing and decreasing the field of view is like zooming out and 

in on a photograph respectively. Increasing the field of view will look 

like you’ve taken a photograph using some fish eye lens, giving you 

an immense sense of depth. Decreasing the field of view will look like 

you’re slowly bringing your model closer to an axonometric drawing, 

reducing the sense of depth to almost a flat 2d drawing.

3.4.4 Toggle Collision Detection

Turning on collision detection stops you from moving through objects 

in your model. This can be important if you’re moving through very 

tight spaces or you just don’t want to jump off a ballustrade. Collision 

detection works by checking the vector of movement of the camera 

for any obstructions, if any are found you’ll be stopped from moving 

in that specific direction. Being able to toggle this on and off gives you 

the opportunity to move through obstructions like doors and foliage 

when you need to.

3.4.5 Toggle Vertical Movement Restiction

If you want to maintain up and down movement to the vertical axis 

(blue), then toggle the Vertical Movement Restriction on when you 

need it. This will give you the ability to move up and down regardless 

of the camera’s line of sight.

3.4.6 Toggle Camera Eye Height

Turning on Camera Eye Height allows you to move up and down 

stairs smoothly without having to mash so many buttons to do so. This 

feature is important to simulate movement across your model like a 

visitor, occupant or user would.

3.4.7 Toggle Camera Upright

Toggling Camera upright can help you move through your model 

smoothly. It stops the camera from rolling left or right when you’re 

moving through the model.

So hopefully now you can move through your model like a pro with a combination 

of these tools, but what if you’re not moving fast enough? or you feel like the 

movement’s a bit sluggish? or you want to change the way the Floating Camera 

looks (pans and tilts)? or you’d rather some different defaults for the toggles 

when you run Floating Camera? Let’s take a look at the settings window next so 

you can tune Floating Camera to suit your preferences.
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3.5 Settings
So this is what the Settings window looks like:

Figure 2. Floating Camera Settings window (version 1.0b1)

You can access the Settings window by clicking on the Settings button in the 

toolbar:

Figure 3. Default Camera Settings from the Floating Camera Settings window (version 1.0b1)

3.5.1 Default Camera Settings

The Default Camera Settings control the default values of the camera. 

When you click on the Floating Camera button, these defaults will be 

loaded. (See 3.4 for a description of each of these default settings)

3.5.2 Look Settings

The Look Settings control how you pan and tilt the camera in 

Sketchup. You can either enable Maximum Rotation, or Infinite 

Rotation.

Figure 4. Maximum Rotation enabled from the Floating Camera Settings window (version 1.0b1)

3.5.2.1 Maximum Rotation

Maximum rotation allows you to rotate the camera by a set 

amount of degrees. Maximum Rotation works kind of like 2d 

physics. The further and quicker you drag the mouse, the faster 

the camera will rotate. If the mouse is then still, the camera 

will slow down as it gets closer to its target. The Degree value 

controls the maximum rotation possible based on a 1080p 

widescreen with the Sketchup window at full size. Navigating 

by Maximum Rotation is often easier than navigating by Infinite 

Rotation. If you have trouble with rotation using Infinite Rotation, 

try Maximum Rotation with a large degree value (like 1080 

Degrees).

So this is what the Settings window looks like:

Chapters
1. Introduction

2. Installation

3. Basic Use

4. Improving Performance

On this page
3. Basic Use

Documentation Version
Version 1.0b1

Check for Updates
Visit [plugin] Floating Camera at 

forums.sketchucation.com

Author
Niall Campbell

(bentleykfrog)

video-game style navigation and camera animation in 
google’s sketchup

fl oating camera fl oating camera fl oating camera fl oating camera fl oating camera fl oating camera |||



Figure 5. Infinite Rotation enabled from the Floating Camera Settings window (version 1.0b1)

3.5.2.2 Infinite Rotation

Infinite Rotation allows you to rotate the camera infinitely at 

a set speed of rotation. Infinite Rotation works kind of like 

Sketchup’s walk tool. The further you drag your mouse away 

from your initial click location, the faster the camera will rotate. 

To slow the rotation down, drag the mouse closer to the initial 

click location. The Degree value controls the speed of rotation. 

In the figure of the Settings window above this value is 180 

Degrees. Using Infinite Rotation is good for video game like 

exploration of your model, but its often difficult to get smooth 

rotations for animations and presentations using this style 

of rotation. The reason for this is that its quite hard to slow 

down the camera rotation smoothly using the mouse. If you’re 

having difficulty producing good quality animations with Infinite 

Rotation, try Maximum Rotation with a high Degree value.

Figure 5. Infinite Rotation enabled from the Floating Camera Settings window (version 1.0b1)

3.5.3 Speed Settings

The Speed Settings control the camera’s maximum speed in 

kilometres per hour and the inertia (friction) experienced by the 

camera when approaching the maximum speed and then coming 

to rest. The maximum speed setting doesn’t really need much 

explanation here, but the inertia setting does. Inertia has an effect 

on both the acceleration of the camera and the rotation of the 

camera. Changing Inertia to a higher value will increase the friction 

the camera experiences, so reaching the top speed, changing 

direction, rotating the camera and coming to rest will take a long time. 

Changing Inertia to a lower value will reduce the friction the camera 

experiences so the camera reaches top speed, changes direction, 

rotates and comes to rest in a very short time.
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4.Improving Performance
When you load the Floating Camera tool by clicking the Floating Camera button: 

 , the script attempts to give you the best performance possible. Floating 

Camera disables almost all the visual effects Sketchup provides to limit the amount 

of computing power required. It disables features like: Transparency Quality, 

Edge Colours, Edge Styles, Dimensions, Textures, Fog, and Shadows. Generally 

speaking, these effects aren’t required until you want to render a final animation, 

and just get in the way of good, smooth movement. There are a few settings you 

can choose that will also improve the performance of Floating Camera.Face Style

Frame rate in Sketchup is heavily dependent on the system running Sketchup. 

One of the easiest ways of improving peformance is to change the Face Style. 

You can change the Face Style by selecting the menu ‘View’ -> ‘Face Style’ and 

selecting the Face Style you want. ‘Shaded with Textures’ is the most system 

intensive Face Style available in Sketchup. Both ‘Monochrome’, ‘Shaded’ and 

‘Hidden Line’ improve the performance of Floating Camera equally (on my 

system, it increases graphic performance by roughly 50%). ‘Wireframe’ offers 

the best performance and doesn’t interfere with Camera Eye Height or Collision 

Detection, but it can be quite hard to navigate (on my system, wireframe 

increases graphic performance by 80%).

4.1 OpenGL Settings

OpenGL settings have an unusual effect on Sketchup’s graphic 

performance. To ensure good quality graphic performance, make 

sure you have ‘Hardware Acceleration’ enabled by accessing the 

OpenGL settings in the menu ‘Window’ -> ‘Preferences’ -> ‘OpenGL’. 

With Hardware Acceleration enabled you should see a massive 

improvement in performance. There are also two more options to 

choose from in the OpenGL settings window: ‘Fast Feedback’ and 

‘Maximum Texture Size’. Generally speaking, Fast Feedback doesn’t 

have a great effect on graphic performance in Floating Camera. This 

is because Floating Camera uses Sketchup’s animation capabilities 

to move from one point to the next, and Fast Feedback is ignored 

when Sketchup runs animations. Disabling Maximum Texture Size will 

only have an effect if you have textures in your model larger than 

1024x1024 pixels.

4.2 Graphics Card Settings

Some modern graphics cards have the ability to choose settings like 

anti-alias quality and ansiotropic filtering. As far as I know, modifying 

these is only possible on PC. Depending on your card, enabling 

these settings to their recommended settings will give you better 

performance in Sketchup. Ideal settings will vary from card to card, 

so do a little search on Google for your card’s graphic benchmark 

performance. Generally speaking, these benchmarks will include 

graphic intensive games like Crysis or Left 4 Dead and test the 
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different settings on the card. These benchmarks of graphics card 

settings can be used to find the ideal settings for Sketchup, and 

hopefully you’ll see a performance increase in Sketchup.

Alright, hopefully you’ve got Floating Camera working the way you like 

it. That about wraps it up for this beta release of Floating Camera, If you’ve 

got any suggestions or experience any problems you can drop a post on the 

sketchucation forum in the Floating Camera thread
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